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1. FILEHOLD 16.2.4 OVERVIEW

This document is a high-level description of the new features and enhancements of FileHold
16.2.

2. SYSTEM REQUIREMENTS CHANGES FOR FILEHOLD 16.2.4

The minimum hardware requirements to run FileHold Enterprise or FileHold Express in a
production environment that have been changed for this release are listed below.

For a list of full system requirements, visit https://www.filehold.com/how-to-buy/system-
requirements.

2.1. Application Server Requirements
1 Windows 2019 Standard Edition Server is now supported.
1 Windows 2008 R2 Standard and Enterprise Edition Server is no longer supported.
2.2. Database Server
1 SQL Server 2019 Enterprise, Standard, Express is how supported.
1 SQL Server 2008 R2 is supported for upgrades only.
2.3. Microsoft Office Integration
1 Microsoft Office Professional Microsoft Office Professional 2007 is no longer supported.
1 Microsoft Office Professional OneNote 2010 is no longer supported.
2.4. Microsoft SharePoint Support

1 Microsoft Office SharePoint Services 2019 is now supported.

1 Microsoft Office SharePoint Services 2016 is now supported.

May 2021 < Hold 1
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3. DOCUMENT REPOSITORY LOCATIONS ENHANCEMENT

In previous versions of FileHold, the repository could be split into multiple logical locations to
improve scalability. In this release, a system administrator can additionally define the preferred
location for documents that fit a particular criterion. For example, a cabinet, such as Human
Resources, can have its own repository locations. The library archive can also have separate
repository locations defined. This makes it possible to store the archive documents according

to IT policies and technologies that allow for less expensive storage and backup. The ability to
have multiple repository |l ocations is control

When configuring document repository locations, groups are configured for their document
preference: default, archive, or cabinet. Within each group is a repository location which sets
the physical storage location. When a file is added to FileHold, the list of preferences is
checked to which group it belongs in. If there is no matching group, the file is placed in the
default group.

Bady [F 8 =

Drag a column header and drop it here to group by that column

Group status Group name Preference Locations Available space Total files
> [ ] Default repository Default 1 36.87 GB 177
> [ ] Archive Archive 1 189 GB 2
[«] ® HR Cabinet 2 451 GB
Location status Location name Path Allow new files Available space Total files.
o Confidential hr docs GIHRRR No 0B
[ ] More confidential docs H:\MoreHR\ Yes 451 'GB

Files in a particular repository location can be moved to a preferred or default group. Files are
moved as a batch and can be viewed in the Batch Jobs report.

Groups and locations can be deleted; however, repository groups can only be deleted if it
contains no repository locations. A repository location can only be deleted if it is empty; in other
words, there are no files.

For customers with the standard or enhanced repository, the Free space and Warning
thresholds can be set and monitored with new gauge controls.
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Location name Human Resources

Location path F\Secure\HR < -

| Allow new Tiles

99.998 GB

Free space threshold

0 10 20 30 40 50 60 70 80 90 100

Warning threshoeld

10 20 30 40 50 60 70 80 90 100

4. AUTO-FILING TEMPLATES T NEW

Auto-filing is a popular feature for our customers. Auto-filing can take documents from the FDA
Inbox, Manage Imports, Automatic document importation, Print to FileHold, the Microsoft Office
integration, the Add Document Wizard, and WebCap scanner inbox and file them into the
appropriate folders based on predefined values. This feature helps reduce misfiling and
enables faster mass importation of documents.

Auto-filing is a long-time feature in FileHold has required skills for editing XML files or dot net
programming to configure and auto-filing script. In this release, library administrators or higher
roles can apply auto-filing to document schemas by configuring auto-filing templates using a
browser-based management interface. The custom or out-of-the-box auto-filing script are still
available for use.

Configuring auto-filing templates can be configured in a few minutes for simple rules while still
allowing complex expressions using industry standard regular expressions and existing and
new FileHold merge tags. The new template configuration interface includes a built-in tester
and validation tool to simply getting your template just right.

ay 2021 € FileHold
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Manage auto-filing template AP invoices
General Library properties Cabinet Drawer Folder Group Folder Test values

[5Z Cabinet definition ~

Name Accounting always

[5% Drawer definition ~

Name like AP Invoices using [[sys|document-schema]]

[5Z Folder group definition ~

Name like 2020 using [[md|Invoice Date|yyyy]]

52 Folder definition -~

Name like ABC Co using [[md|Vendor]]

a < Previous Next >

5. DOCUMENT ASSEMBLY i ENHANCEMENTS

The assemble documents feature can be used to automatically construct new documents
based on the rules set in the assembly configuration. Some new features have been added to
the assemble document feature.

5.1. Watermarks on documents
Watermarks can now be added to documents via the Assemble Documents feature. Document
assembly requires the FileHold level 2 viewer license.
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July FileHold Systems Inc ABC Co
250-4664 Lougheed Hwy 12345 ABC St.
O Burnaby BC VBC5TH Burnaby BC V4V4v4

This Statement of \ =d pursuant to the Consultant Services Master Agreement
between ABC Co (“Clien stems Inc (“Contractor”), effective August 1, 2017 (the
“Agreement”). This SOW iz s. O and conditions contained in the Agreement

between the parties and is made z term not otherwise defined herein shall have
the meaning specified in the Agreeme. =ny conflict or inconsistency between the

terms of this SOW and the terms of this Ag & = of this SOW shall govern and

prevail-

=X  FileHold Systems Inc \’/
O  250-4664 Lougheed Hwy .

; Burnaby BC V5C5T5 ElLGI:lWO}md
Y

o SOW 12345 for Agreement to Perform Consulting Services to ABC
T o

[0}

E Date Services Performed By: Services Performed For:

[0}

e

©

-—

w

This SOW # 12345 (hereinafter called the “SOW™), effec f 1. 2017, is entered into
by and between Contractor and Client, and is subject to the “ng specified
below. The Exhibit(s) to this SOW, if any, shall be deemed to be = event of any

inconsistencies between the terms of the body of this SOW and the ¢ Zxhibit(s)

hereto, the terms of the body of this SOW shall prevail

Period of Performance

The Services shall commence on August 14, 2017, and shall continue through August 31, 2017-

If the optional workflow module is enabled in the FileHold license, watermark templates can be
created by a library administrator or higher role. These templates can be applied during
document assembly. Up to three templates can be applied per assembly job.

uAcId E Edit m Delete -n Settings v D’ Export v

a column header and drop it here to that column
Name ¢+ Description Active Position
client-external-address Center -
client-hostname: Center
client-internal-address Top
Do not print Use for documents that should not be hard-copy Center
printed.
page of pages Bottom
server-external-address Bottom

Custom ad-hoc watermark templates can also be created on demand in the assemble
document feature. Only one custom watermark template can be applied during document
assembly. Custom watermarks can be combined with watermark templates for a total of three
watermarks per document.
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Assemble document(s)

Top

Center Do not print

Input Output Assembly options PDF options Actions Summary

Bottom page of pages

Custom watermark G x

Cancel < Previous Next >

5.2. Watermark merge tag fields
Merge tags can be used with watermarks to insert information into the assembled PDF
document. Information such as metadata field values, system information, and workflow data
can be inserted as a watermark into the newly generated document.
Watermark tags can be added to watermark templates and custom watermarks.
For example, the watermark tag [[sys|filehold-id]].[[sys|document-version]] produces the
following watermark:
1. Open the third party application that you are creating the template for. In this example, a
Microsoft Money invoice is used.
2. Goto File > Preferences and Settings > FastFind Preferences and select the Enable FastFind
check box. Click OK.
3. Goto Tools > FastFind Templates.
4. In the list of FastFind Templates window, c! IN >,
5. The message “Activate the window you £ % mplate to be associated with and
press Alt+N.” appears. Select the thi o a nd type Alt+N.
6. A “snapshot” of the application w gD ey astFind Template window. If the
incorrect window was invoked Qlect N \dow and repeat step 5.
Add FastFind Template —
Test Template  Edit [ Add Rui-
Name:
i C Vendor List Payrol
i View or edit an existing invoice: Accounts Receiva
Rules: it E;’:‘b’::t;wm Customer: [ Marvins Muffns
ome ree ‘ia %ie:;zapaym!r\lfm EE::ZA‘ddre;s Laseaakm Creseert, Burnaby, BC, VSE3I9, CA
“i [(agdtern | (Edttem | Defetetem | [(add 1
‘1 e Send invoice to > Item: FilleHold Software
5.3. Building documents with merge tag fields
Document s c aasedorneW imarge tagsgsuch as an agenda. These new merge
tags are available for both document assembly and converting to a PDF in a workflow.
i € FilcHold
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i1 Link inserts a link to another document in FileHold. It displays as a hyperlink in the
assembled document.

1 Embed embeds a FileHold document into the source document. The embedded document
can be password protected to protect sensitive or confidential information. The embed
option displays as a paperclip icon in the assembled document.

1 Expand expands the contents of a FileHold document in the source document. The
formatting of the assembled document can be taken from the source document, replaced
by the expanded document, or merged. The expanded document must be one of the
supported file types: .doc, .docx, .dot, .docm, .dotx, .dotm, .html, .rtf, .txt. Merge tags can
also be placed within the expanded document.

For example, the following merge tags are placed in a Microsoft Word document:

1. [[link]2|Link(Default WebClient),Text(This is a linked
document)|Document not available]]

2. [[embed|11,This is an embedded document and protected with a
password|Document not available]]

3. [[expand|167|Format(Replace)|Document not available]]

€ FileHold ,
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After document assembly, the resulting document looks like this:

Agenda

Lorem tpsum dolor sit amet, consectetur adipiscing elit. Maecenas ac dui eget lacus lacinia
convallis. Curabitur elementum eget sem vel consectetur. Vestibulum ante ipsum primis m
faucibus orci luctus et ultrices posuere cubilia Curae; Fusce non volutpat ipsum, eu rhoncus
justo. Duis dignissim 1n risus tristique tempus. Quisque tincidunt elit elerfend auctor luctus.
Maecenas non libero dapibus sem feugiat tristique. Praesent tempus neque sit amet tellus
consectetur pretium. Proin sit amet massa faucibus, condimentum lectus sit amet. lacinia
dolor. Cras nisi neque, condimentum vitae placerat eu. fringilla nec lorem. Nunc ultrices
egestas mauris, 1d finibus nunc fimbus sit amet.

Cras 1d lectus sapien. Cras et sollicitudin lacus, dapibus elementum nunc. Suspendisse semper
augue eget tincidunt interdum. Maecenas in eros dolor. Nullam commodo, metus vitae
placerat vehicula, dolor quam convallis velit, at hendrerit ante metus 1d dui. Nullam commodo
velit vitae sem maximus 1aculis. Cras at odio ultrices, commodo massa nec, tmcidunt leo.
Aenean malesuada libero eros, a efficitur nibh maximus et. Vivamus et fingilla diam.
Maecenas in pretinm metus, vitae fermentum velit. Praesent quis urna id est fringilla vulputate
eget quis ligula. Donec non nibh a quam ultrices blandit sed quis lectus.

This is a linked document Linked document

To access this document, enter the passwnrd: e Embedded Wiﬂ'.l password
protection

The following text is using the “expand” merge tag

<beginning of expa text> e Expanded text from another
document

Documents can be “built” based on new merge tags, such as an agenda. These new morge
tags are available for both document assembly and converting to a PDF in a workflow.

* Link inserts a link to another document in FileHold. It displays as a hyperlink in the
assembled document.

* Embed embeds a FileHold document into the source document. The embadded
document can be password protected to protect sensitive or confidential
information. The embed option displays as a paperclip icon in the assembled
document.

* Expand expands the contents of a FileHold document in the source document. The
formatting of the assembled document can be taken from the source document,
replaced by the expanded document, or merged. The expanded document must be
one of the supported file types: .doc, .docx, .dot, .docm, .dotx, .dotm, .html, .rtf,
.txt. Merge tags can also be placed within the expanded document.

<end of expanded text>

6. FILEHOLD VIEWERS ENHANCEMENT

New file formats are now supported by the FileHold viewer level 2:

; € FileHold ey 2021
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1 XLSX, ODT, CUR, WSQ, and DXF files.

Not every feature of the supported file formats is supported for viewing. It is recommended that
you test your documents in the viewer in order to determine how your documents are rendered.

7. DATE AND TIME ENHANCEMENT

In previous versions, all times entered or viewed in the system were in the context of the time
zone of the SQL server. In this release, each user can control their time zone. If a user in Berlin
adds a document at 4 pm, a user in New York will see it has been added at 11 am.

In previous versions, most dates were formatted in the US regional style. The only exception
was for metadata fields where administrators had full control. Now, users and administrators
can set the date and time formatting for how the dates and times they see in the system. The
short date, long date, short date and time, and long date and time formats can be configured
globally for users by an administrator, individually on each user account, or end users can
configure in their User preferences. The short date format for May 4, 2020 in Berlin can now be
04/05/2020. The New York office could be 5/4/2020 and the factory in Beijing might see the
same date as 2020-05-04.

Environment Settings

Time Zone (UTC-08:00) Padific Time (US & Canada) ~
Short date format Default e
Default
Long date format M/diyyyy
dd/MM/yyyy
Short time format yyyy-MM-dd

Long time format Default a0

The date display format for a date-type metadata field can be set in the field properties. For
customers who have upgraded from a previous ve
dateo format with the previous versionbds date

Mame * | Application Date |
DESCI’\DUOH

2
Field Type * [ Date v |

Field Properties

Date Display Format | Custom format hd |
Custom Format | M/ddiyyyy ” Test |
Test Result | |

Initial Value | current date: time v |

| Save ” Cancel |

Other items to note about the date/time enhancement:

May 2021 ’ HOld
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i Times in the database are now stored in Coordinated Universal Time (UTC). Custom
reports and software may need to be updated to accommodate this change.

1 Email notifications are displayed in the date format of the person being notified.

i For Courier transmissions, internal users see their configured time zone and external users
see the system default time zone.

1 Automatic document importation jobs use the system default time zone.

i File properties extraction rules can have date and time extracted according to the local time
(behaviour of previous versions) or using UTC time.

1 Microsoft Outlook Watched folders, managed imports and watched folders always use local
time.

Upon upgrading to FileHold 16.2, the installer prompts the user to prepare for the time
conversion from local to UTC. The existing SQL Server UTC time offset and how to handle
daylight savings time needs to be set prior to completing the upgrade.

8. ADVANCED SEARCH ENHANCEMENT

New full text search criteria have been added to the Advanced Search screen:

i1 File or metadata i Searches both file contents and metadata for matching search terms.
This search option remains unchanged from previous versions and is the default.

1 File only i Searches file contents only for matching search terms.

1 Metadata only i Searches metadata only for matching search terms. This option replaces
the fiSearch metadata onlyd check box availabl e in

1 Raw query i A direct search in the dtSearch engine with no adjustments made by FileHold.
Raw dtSearch search terms are required for this option. This option is available only to
system administrators by default.

By default, a natural -ittangeageh qiue fulitexesdarcitiGolo gt le e
options above.

Advanced Search Hide Advanced '@
File or Metadata » onta | E
(Al it e rie B Fileonly Il Document Versions L) Search Using Historical Metadata Fields &
Document Name Metadata only
Checked Out Status Raw query optio
In order to conduct Boolean-t ype searches, a new advanced search oy

check box is available. For example:
(banana OR pear OR "apple pie" ) AND NOT (salad or "ice cream" )
finds documents with any of banana, pear or apple pie that do not have salad or ice cream.

The AORO0O and AAND NOTO are not case sensitive.

10 ‘ HOld May 2021
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Advanced Search

File or Metadata « |banana or pear or "apple pie" and NOT salad| Search

Boolean search [ Include archive in search | Include all document versions [_| Search using historical metadata values

,® Ssearch Re. s 1-4 of 4

9. WORKFLOW ENHANCEMENTS

Several workflow enhancements have been made for this release.

9.1. New interface screen for completing tasks

When completing task such as reviewing or approving documents or sending documents for
external signature, a new interface can be used for a more clean and friendly experience that
provides more workflow details to the user. For example, task details, activity title, and previous
workflow activities, comments, and actions can be seen on the same screen. Alternatively, the
old interface can still be used.

The new interface is available in the FileHold Desktop Application, Web Client, and Mobile
client.

ay 2021 € FileHold "



FileHold 16.2.4 Release Guide

submit approval (7]

Contracis - SOWs_GHI Co SOW_Cct-21-2019

Apiprove 1 docurment{s) with 0 supporting decument{s).
Please approve final contract details.

Add 3 comment to your approval

b

Add a file attschment to your approval

No file chosen

In erder to submit wour approval, rejection or postpane approval of all docurents in this workflow, you must enter your FileHold password.

OO

Due date: 1072212049 1:38 PM
Check out- Not allowed
Password: Required

n Step 3: Approval #2 - Deborah Dixon - 1m

| 508 no issuas

[ step 2: Approval #1 - Basie Fie - 0m
Tha changas kedk ok 10 me.

Step 1: Review final draft - sysadm - Om
Imade a fow changes 1o section 2.1. Sae documant.

uAdded initial document - GHI Co Contract - sysadm (1)

The user may be able to choose the interface type, depending on how the administrator has
configured the workflow settings.

Workflow settings (7

Workflow permissions

The following setting determines if one workflow or multiple workflows are initiated when multiple documents are selected.

One Workflow -

The following setting determines what user interface will be available for completing tasks.

mership when initiating workflows or sending Courier transmissions

New only

Classic only stadata when a workflow or Courier approval transmission is active

9.2. New modifiers for the signoff-sheet merge tag

The PDF converter or Assemble document settings allow you to set up merge templates that
can convert documents to a PDF and append information such as the workflow signoff sheet. A
merge template uses fAtagso in order to insert Fil

B ©FilcHold
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The [[sys|signoff-sheet]] merge tag adds workflow sign off sheet information to the end of the
document when converted or assembled. The following have been added for horizontal or

vertical table opt

ions:

T A new modifier fAlncludeReviewersodo has been adde
17 Anewmodifer ACol umnod that can work with all fields
The modifier allows the user to specify whether a specific field should be included in the
sign off sheet by specifying a true or false value. True causes the field to be included and
false causes the field to be suppressed. Several fields are set true by default including
participant, date, on-behalf-of, document name and workflow name. The fields appear in
the table in the order they are specified in the tag.
T A new ACIlIoe anmoRdiieflidesr makes all fields false (do
T A new fiDateFormato modifier allows a user to sp
in the signoff sheet. The format must follow standard dot net formatting code.
i Existing columns include participant, date, on-behalf-of, document-name and workflow-
name. This specification adds two new columns to the table: participant-type and comment.
Participant type is fAReviewero or fAApprovero. N
1 Theheadingfortheparti ci pant col umn changed from fASigne
and the date column heading changed from AAppro
For example:
[[sys|signoff - sheet|horizontal, IncludeReviewers , Column (document -
name,false),  Column (workflow - name,false), Col umn(participant -
type), Column(comment)]]
Will give the following output:
Participant name | Date On behalf of Participant type | Comment
April Ludgate 7/22/2019 Reviewer No comment.
Leslie Knope 7/23/2019 Approver | took your idea
and made it
better.
Ron Swanson 7/24/2019 Approver The less | know
about this, the
better.

For example:
[[sys|signoff
inserted]]

- sheet|horizontal,ClearFields|This value is always

Will give the following output:

This value is always inserted

9.3. New merge tags for convert to PDF

New merge tags are available for both document assembly and convert to PDF. The merge

tags are:

May 2021
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1 Link
1 Expand
1 Embed

See Building documents with merge tag fields for more information.

10. MINOR ENHANCEMENTS

Some minor enhancements have been made to FileHold.

10.1. Performance improvements

T I'f using fiGet a | ocal copyo with a | arge page si z
now downloaded significantly faster.

1 The length of time database tables are locked when downloading as zip has been
significantly reduced.

i1 For developers, a new method has been added to the document finder service called
GetDocumentsWithField that can be used in place of GetDocumentsBySnapshot except
this new method allows you to specify the metadata fields to return instead of relying on the
view. This can help avoid repeated calls to GetDocumentDetails by allowing the developer
to specify the fields to be returned.

1 Another improvement for developers allows more than one document version at a time to
be specified for download without using download as zip. A single call to
DocumentManager.PrepareMultipleDocumentsToDownload will return a list of tokens
ready for download.

1 FDA inbox and manage imports processing is much faster when documents have
extraordinarily long dropdown menus.

i1 FDA login speed improved especially over WAN connections and with large numbers of
document schemas.

1 Adding documents that include metadata fields with very long dropdown menus is now
faster.

i1 The FileHold Office Client (FOC) loads faster when there are many schemas in the system
(400+).

10.2. Deleting Working Documents
Working documents are documents that have been checked out or downloaded in the FDA.
The deletion of working documents has been enhanced so that documents can be:
1 Automatically deleted without user intervention (new).

i1 Prompted prior to deletion and given the option to cancel the deletion (present in previous
versions of FileHold).

These options can be controlled by an end user in the User preferences or by a system
administrator in the Client Options > FDA advanced settings.

The working documents folder may be cleaned automatically or the user may be prompted
under certain conditions. This is controlled by the system administrator in the Client Options >
FDA advanced settings.
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1 When the FDA is minimized to the system tray.

1  When the user logs out.

1 When the FDA detects it has been disconnected from the FileHold server.
1 When the FDA receives a message from Windows to shut down.

Local files that are in use by another process are not deleted and remain in the working
documents and will be processed the next time there is a trigger condition. Local files
associated with electronic documents that are modified will not be deleted. These files should
be managed using manual check in or the working documents synchronization tool. Once the
documents have been checked in / synchronized they will be subject to the automatic deletion

rules.
Client Options 7
e ———
FDA Advanced Settings
Enforce Option name Values Reset default value for all users
Show Welcome Screen at startup [ Enabled v]
Default screen at startup | Blank v |
Maximum simultaneous transfers (1-5) | 1 |
By default delete documents that a user Adds to FileHold [ Disabled v ]
By default delete documents that a user Checks In to FileHold [ Disabled v ]
Prompt for Download Location when a user Makes Copies of Files [ Enabled v ]
Prompt for Download Location when a user Checks Qut Files [ Enabled v ]
Prompt user to remove files when sending them from the Inbox [ Enabled v]
) Automatically clean up user's working documents [ Enabled v ]
() Prompt before automatically cleaning up user's working decuments [ Disabled v]
) When the FDA is minimized to the system tray.
Clean up working documents extended conditions: l7 SR EElEar
") When the FDA detects it has been disconnected from FileHold server
) When the FDA receives a message from Windows to shutdown.

10.3. Disabling the PDF/Image Viewer

By default, the PDF/Image viewer will be disabled upon install or upgrade. The PDF/Image
viewer is being deprecated with this version so it is recommended that users transition to the
FileHold viewer.

Users can re-enable the PDF/Image viewer in their User Preferences > Viewer tab or a system
administration can re-enable in the Client options > FDA advanced settings.

My User Preferences ? X

General Advanced Viewer Contact Information Company Information
Document Viewer Settings
PDF/Image viewer only

0 Enable the old FDA PDF/Image viewer. This viewer is end-of-ife. Transition to the FieHold viewer as soon as
possible.
Orientation of the thumbnai view | Bottom

PDF/Image viewer and Brava viewer

©FilcHold .
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10.4. Disabling the Brava Viewer

System administrators can now disable the Brava viewer so it will no longer be able to open
nor redact a document. The Brava viewer has been deprecated since 2017 so it is
recommended that users transition to the FileHold level 2 viewer instead.

The Brava viewer can be disabled in the Document viewer settings.

$FileHold

My FilcHold

[Edit Brava Office viewer Configuration Settings

User: sysadm | Help

| Logout

Workflow management ‘ Disable the Brava viewer technology. This third party technology is end-of-life. Transition your users to the FileHold viewer as soon as possible

Library management © pisable the Brava viewer technology

System management The following page allows you to control which features of the document viewer are available to users when using the FileHold Desktop Application. Simply select the document viewer features you want to enable for this

Administration reports
L Check All | [ Uncheck All

System configuration

Allow Users To Publish Documents As Adobe PDF Files
Settings
J Allow Users To Publish Documents As Tiff Files
General
J Allow Users To Save View In Jpeg Format
Search

J Allow Users To Print / Print Regions Of Documents

Notifications J Allow Users To Compare Documents

Security J Allow Users To Create ISO Banners / Watermarks For Printing

Document repository locations J Allow Users To Copy Text and Markups In A Document To The Clipboard

Client options ) Allow Users To Copy Regions Of Image Files To The Clipboard

Library configuration

O

[

[

!

[

2 Allow Users To Publish Documents As Csf Files
[

C

[

L Allow Users To View / Create / Edit Markups
!

J Enable Document Redaction

10.5. Disabling downloading and viewing for groups

viewer configuration and click save. Go to the system administration > manage users list to provide users with a license to use the document viewer feature.

Save Cancel

A new group restriction has been added to the group properties: Disable viewing. If enabled,
this restricts users from viewing document in the FileHold viewer. This option is available for

groups with a role of document publisher or lower.

For the disable download and disable printing options, these are now included for groups with
a role of document publisher. In previous versions, only read-only or limited roles had these

options available.

Group Name * [ Human Resources |
Description | |
Role* '@ [ Document Publisher v |
Notes

FileHold Group Members I Display all members in one page

Name
8 Basie Pie

Add Members

Restrictions () pisable emailing documents
¥ Disable sending to Courier
[ Disable download (open, local copy)
) Disable printing
2 Disable viewing
oK || cancel || Apply |

Source
Local

) ©FilcHold
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10.6. Extended error messages

An extended error message is now displayedifan fAunexpected erroro
versions, administrators needed to access the event log on the server to view the error. The
Aunexpected error 0 be¢asssandgCepynocCwpbbanddlittand. §tas
message can used to assist a user or administrator in solving the issue.

Extended messages appear in the FDA, web client, mobile, and Courier clients.

€ FileHold

Unexpected error

An unexpected error occurred. Please try again or contact your system administratar.

Go to Library

Hide Details | [ Copy to Clipboara

System.Net.WebException: The operation has timed out

at System.Web.Services.Protocols.WebClientProtocol. GetWebResponse(WebRequest request)

at System. Web. Services. Protocols. Hitp\WebClientProtocol GetWebResponse(WebRequest request)

at System Web_Services Protocols SoapHttpClientProtocol. Invoke (String methodName, Object]] parameters)

at FileHold WebClient UserPreferencesService. UserPreferences GetUserPreferences() in
c:\Builds\5\FH\FileHold 16.2\src\FileHoldWebClientWeb References\UserPreferencesService\Reference.cs:line
1161

at FileHold. WebClient.Language. GeiPreferredLanguage() in
c’\Builds\5\FH\FileHold16 2\src\FileHoldWvebClient\Code'\Language.cs:line 73

at FileHold WebClient.BasePage.InitializeCulture() in
C:\Builds\5\FH\FileHold16.2\src\FileHoldWvebClient\Code\BasePage.cs:line 99

at ASP.libraryform_aspx.__BuildControlTree(libraryform_aspx __cirl)

at ASP libraryform_aspx. Frameworklnitialize()

at System Web Ul Page ProcessRequest(Boolean includeStagesBeforeAsyncPoint, Boolean -
includeStagesAfterAsyncPaoint)
at System Web Ll Page ProcessBeguest) 2

© 2019 FileHold Systems Inc.

10.7. Logging changes to drop-down metadata fields

If changes are made to any type of drop-down metadata field, it will now be recorded in the
Library audit log. This includes the type of change: Added, Deleted, or Changed. The following

columns have been added to the log: New lookup by, New retrieve from, Action, Old lookup by,

Old retrieve from, and (number of) Affected documents.

occur s.

I User name | Basie Pie (13) (7]

4 Description contains | contract manager |
lAFrom| ‘@ T0| ||§

| Apply Fiter || Exportas csv |

Library Audit Log

Page size -30 v

Full name User login name Description Action Date Affected documents
sysadm sysadm (1) 1 value(s) for. Contract manager (41) were updated 2019-10-21 13:07:40 -07:00 0

sysadm sysadm (1) Added metadata field: Contract manager (41) 2019-10-17 10:52:23 -07:00

sysadm sysadm (1) 3 value(s) for: Contract manager (41) were updated 2019-10-17 10:52:23 -07:00 0
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Page size |30 v

Action Updated menu option Original menu option
Added April Ludgate

10.8. New FileHold Desktop Application header

New larger minimum, maximum, and close buttons have been added to the FDA header. This
makes it easier for users to access these buttons.

The server URL has also been added to the header. This allows users to quickly see what
FileHold server they are connected to or disconnected from. This is helpful if an organization
has multiple FileHold servers.

. Larger minimize, maximize
FileHold server URL Username g '
and close buttons
*  Connected to http://win-55bmeutro2m/FH/FileHold Basie Pie - o X
File View Tools Administration Help pel

10.9. Users list enhancement

Information about domain groups has been added to the Users page. This makes it for easier
for system administrators to see what domain group a user is in without having to go into the
user properties.

The User type column now states if the placeholder domaingroup bel ongs to a fADomain
groupo. The | nh e rdisglagsdhe game af ang FileHoldl gromps that have a
domain group assigned to it and the user is a member of.

NOTE: Domain group proxy users arealwaysfidi sabl edd. To s emxyusere domain g
in the Users 1|ist, make sure the User status col umn
filter to see all statuses.
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